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MiCODUS 2G Device Firmware Upgrade

l.Upgrade Overview

(I) Purpose of Upgrade

Since the 16th August 2025, our monitoring systems have detected GPS-related
functional anomalies in some positioning devices. Our technical investigation has
confirmed that this issue stems from the GPS Week Number Rollover (WNRO)
problem affecting the MediaTek MTK 2503D chip (which incorporates the MT3333
positioning chip). The specific symptoms include: GPS date stamps resetting to
January 1st, 2006, and unstable or intermittent positioning functionality.

(1) Applicable Models and Firmware Versions
This firmware upgrading ONLY applies to the following affected 2G device models:

MV710, MV720, MV730, MV740, MV760 and MV790.

Since these devices do not support OTA (Over-the-Air) remote upgrades, the
firmware must be updated manually via the configuration cable. There are no specific
restrictions on device versions—any units of the above models are eligible for this
upgrade.

() Functional Advantages and Differences After the
Upgrade

1. Function Compatibility Retained

1) Local Upgrade (Manual via Configuration Cable):
This upgrade only addresses the GPS time synchronization issue. After
completion, all original device functions (including GLONASS positioning)
remain unchanged, with no impact on operating logic, parameter configuration,
or usage methods. No functions are removed, and compatibility is fully preserved.
2) OTA Remote Upgrade (Not Applicable to This Device):
Performing an OTA upgrade may cause the device to lose GLONASS positioning
capability. By adopting the local upgrade method in this case, the issue is
completely avoided, ensuring the GLONASS positioning function remains fully
enabled.

2. Core Performance Optimization
After the upgrade, the GPS signal reception performance of the device is significantly
improved.
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ll.Upgrade Preparation

(1) Required Tools and Materials

1. Computer: Ensure the computer is running a Windows operating system
(Windows 7 or later is recommended), with stable performance and free of viruses.

2. Serial Port Driver Software: CH340 driver, used to enable serial communication
between the computer and the device.

3. Upgrade Software Package: Multiport download exe v5.1624.00, which
contains the necessary programs for firmware upgrading.

4. Configuration Cable (Serial Cable): Used to connect the computer and the device
for data transmission. Ensure the cable is intact and undamaged.

5. Device Firmware Package: For example, MV710 MV790 2410314 or
MV720 MV730 250318A.

6. 2G Devices to be Upgraded: The applicable device models listed above.

(1) Data Backup

Although this upgrade mainly addresses the time synchronization issue and has
minimal impact on other device data, it is recommended to back up important data
before proceeding. Data can be backed up using the device’s built-in storage function
and copied to an external storage medium (e.g., USB drive).

(Ill) Device Status Check

1. Device Appearance Check: Inspect the device interfaces to ensure they are intact
and free from damage or deformation, so that the configuration cable can connect
properly.

2. Configuration Cable Connection Check: Connect one end of the configuration
cable to the computer (leave the other end temporarily disconnected from the device).
Verify that the computer can recognize the hardware associated with the cable.
(Detailed illustrated instructions will be provided in subsequent steps.)

3. Device Status Check: Ensure the device has sufficient battery power and is
connected to external power before proceeding.
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lll. Upgrade Steps

(1) Install the Serial Port Driver

1. Place the file in Disk D: and extract the contents.

G J > ThisPC > #Fm&E (D) > Upgradation steps >

N Sort ~ = View v
Name ) Date modified Ty
Driver for Program 25/08/2025 11:33 Fi
Firmware for MV710 MV720 MV730 MV740 MV790 25/08/2025 11:33 Fi
Firmware Upgrading Program 25/08/2025 11:33 Fi
&) MiCODUS 2G Device Firmware Upgrade Steps 25/08/2025 10:49 W

2. Open the CH340drive folder and double-click CH341SER.exe to install the

driver.
% CH341SER 09/07/2013 10:12 Application
% DriverSetup(X64) — b4

Device Driver Install { Uninstall

Select INF File : |CH341SER.INF

WCH.CN
it |__ USB-SERIAL CH340
| 11/04/2011, 3.3.2011.11
UNINSTALL
HELP

Note: During installation, disable any antivirus software on the computer to prevent it
from blocking the driver installation. If the installation fails, try restarting the
computer and then reinstalling the driver.

(1) Verifying the COM Port

1. After installing the driver, connect the serial cable (configuration cable) to the
USB port of the computer.
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2. Right-click “My Computer” and select “Manage”. In the pop-up Computer
Management window, navigate through System Tools — Device Manager —
Ports (COM & LPT). Locate “USB-SERIAL CH340 (COMX)” (where X is
the specific port number, e.g., COM3) and note down the COM port number.

PEE R T W
mi' Open

Pin to Quick access

Manage &—_

Pin to Start

Map network drive...
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e
‘ & Computer Management = o X

‘F_l\e Action View Help

- B Bl &= B RXE
& Computer Management (Local)|| ~ & CHINAMI-VINGVDN Actions
~ |} System Tools » i Audioinputs and outputs e -
d @ Task Scheduler i Audio Processing Objects (APOs)
8] Event Viewer B computer More Actions »
21| Shared Folders > Disk drives
» &% Local Users and Groups [ Display adaptors |
5)) Performance » B Firmware
& Device Manager > @ Human Interface Devices
v 55 storage » @ IDE ATA/ATAPI controllers
& Disk gement » &2 Keyboards
s Services andipplications @ Mice and other pointing devices 2
B Monitors

@ Network adapters
@ Ports (COM & LPT) /’ 3
i USB-SERIAL CH340 (COM3)
W EEHN comn)
» = Print queues
1 » [ Processors
07 Security devices
¥ Software components
> Software devices
i Sound, video and game controllers
» S Storage controllers
K= system devices
i Universal Serial Bus controllers

<

Note: If the port is not found, the driver may not have installed successfully or there
may be an issue with the configuration cable. Recheck the driver installation and
cable connection. If multiple COM ports are present, ensure you identify the one
related to this connection.

(Ill) Prepare the Upgrade Software

Open the extracted Multiport_download_exe v5.1624.00.00 folder, navigate to the
“output” folder, and locate the upgrade
software“MultiPortFlashDownloadProject”. Double-click to open it.

J > - Multiport_download_exe v5.1624.00.00 > output > Search output
N sort ~ = View v
Name B Date modified Type Size

| 1 MDTDATA 16/06/2016 11:09 File 1KB
\'\: META_DLLdIl 16/06/2016 11:09 Application extens... 3,664 KB
%] mfcoo.dll 16/06/2016 11:09 Application extens... 1,130 KB
t Microsoft.VC90.CRT.manifest 16/06/2016 11:09 MANIFEST File 1KB
\: Microsoft.VC90.MFC.manifest 16/06/2016 11:09 MANIFEST File 1KB
E miodILdll 16/06/2016 11:09 Application extens... 152 KB
%] msvem90.dll 16/06/2016 11:09 Application extens... 220 KB
[ msvcp90.dll 16/06/2016 11:09 Application extens... 556 KB
E msver90.dil 16/06/2016 11:09 Application extens... 641 KB
LL MTK_AllInOne_DA bin 14/06/2016 21:28 BIN File 6,247 KB
\: MTK_AllInOne_DA_MT3333_MP.BIN 14/06/2016 21:16 BIN File 12 KB
t MTK_DATABASE.mdb 16/06/2016 11:09 MDB File 3,192 KB
O MuitiPortFIashDownloadP{oject.dW DRC File 31 KB
Hi MultiPortFlashDownloadProject 16/06/2016 14:17 Application 2,512 KB
y | MultiPortFlashDownloadProject 23/08/2025 11:47 Configuration sett. 2 KB
0 MultiPortFlashDownloadProject.lib 16/06/2016 14:17 LIB File 13 KB

\: MultiPortFlashDownloadProject. map 16/06/2016 14:17 MAP File 1,457 KB
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(IV) Load the Download Agent File

1. In the upgrade software interface, click the “File” menu and select “Open
Download Agent File” .

S Multiple Download Tool - Engineer Mode — X
File Factory Database Options Debuglogging Identify Help

Open Download Agent File thad_exe_vﬁjBZ4.IJI10|]\0M\NITX_AIrﬂne_DAbi‘I
Open Authentication File

Scatter and Load

Open Root Cert File
Open Certificate File

GG L Y § G 1 IS 1 au

Image Folder] |o:\umwm;m=ps\wm_wm_zsmm Reload
COM Port
i @« UART
v COM3 [ Auto poliing 3 . Dsec _Stat | Stop |  use
[~ COM4 [ Autopoling4 @) Osec  Stat | Stop | " UART +USB
[~ COMS [ Autopoling5 @@ Osec  Stat | Stop |
[~ coMs [ Auto poliing 6 . Osec  Start I Stop | Baudrate |921600 :lv

[~ coM7 [ Auto poliing 7 .
[~ COM8 [ Autopoling8 @)
I~ COM3 [~ Autopoling9 @@
[~ COMI0 Auto poling 104
[~ COMT1I™ Auto poling 1)
I~ COM12I™ Auto poling 12¢)
[~ COM13[~ Auto poling 13@@)
[~ COM14 Auto poling 14
[~ COM15[" Auto poling 154
I~ COMIB[™ Auto poling 16
[~ COMI7[~ Auto poling 17
[~ COM18[™ Auto poliing 13.

Osec  Start | Stop | Download/Format |

Dsec  Stat | Stop | Dperation
Osec  Start | Stop | IDownluad ROM 3
Osec  Stat | Stop |
Osec  Stat | Stop |
Osec Start | Stop |
Osec  Stat | Stop |
Osec Start | Stop |
Osec  Stat | Stop |
Osec  Start | Stop |
Dsec  Stat | Stop |

Osec  Start | Stop | Start Al | Stop Al |

[=1 1 =1 ] o] ] ] (o] ] ] (] (] ] (] ] (] e}

2. In the pop-up file selection window, navigate to the “output” folder of the
extracted upgrade software package, select “MTK_AllInOne_DA.bin” , and
click “Open” .

R Open X
Look in: I output LI & 5 ER~
Name - Date modified
backup 21/08/2017 19:52
_ backup_and_restore_data 23/08/2025 11:04
[7] gps_DA.bin 14/06/2016 21:16
{| ] MTK_AlllnOne_DA.bin 14/06/2016 21:28
D MTK_AlInOne_DA_MTER23 MP.BIN 14/06/2016 21:16

7
3

1 1 I

[

File name: [MTK_AlinOne_DA v Open |
Files of type: | Bin File (*bin) M Cancel

A
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(V) Configure Software Settings

In the upgrade software interface, locate the “Options” menu and check the required
settings (refer to the figure below).

## Multiple Download Tool - Engineer Mode = X
File Factory Database Options Debug Logging Identify Help

D file name D:\Upgr bin

Authentication file Baseband chip options >

RootCert file Backup and restore calibration data options >

Certificate File Set begin COM port

USB Download W/O Battery

fig Files Folder§ USB Download/Format (Data Card)
D:\Upgrac Reload
USB Download/Readback(External Modem)
 Sell Enable MMAA (Multi-Load with Multi-Memory) E?DMU::':

v COM3 [ Auto polling 3 Send RootCert Forcely .  uss
¥ COM4 [ Autopoling 4 " UART +USB
[ COMS [ Auto poling 5 v Enable USB 1.1 to 2.0
[ COME ™ Ao poling8] Disable Long-Press Power Key Setting Baud rate | 921600 '[
[ COM7 [ Auto poli «  Backup Nvram Partition e |
v COM8 [~ Auto Enter Meta Mode after DL/FMT Operation
f’z E.ngﬂl': Auto z:::::: Settings... 7 Download ROM zl
% o Auto poling¥!__ Nor/SF Flash Safe Mode
v glm121" Auto poling 124 [ 0% ] Osec Stat| Stop |
[ COM13[™ Auto poling 13@) [0 ] O0sec Stat| Stop |
[V COM14T™ Auto poling 14 [ 0% ] O0sec Stat| Stop|
[¥ COM15[™ Auto poling 15 [0 ] O0sec Stat| Stop |
[¥ COM1BI™ Auto poling 164 [ 0% ] O0sec Stat| Stop |
[V COM17[" Auto poling 17 @) [ 0% | Osec Stat| Stop |
[ COMIS[™ Auto poling 184 [ % ] Osec Stat| Stop| Start Al | Stop Al I

(V1) Extract and Select the Upgrade Firmware Package

1. Extract the upgrade firmware package for the corresponding device model to
Disk D: (skip this step if already extracted).

@ [J > ThisPC > #FI¥% (D) > Upgradationsteps >

0 @p N Sort v = View v e
Name : Date modified
Driver for Program 25/08/2025 11:33
‘ Firmware for MV710 MV720 MV730 MV740 MV790 25/08/2025 11:33
Firmware Upgrading Program 25/08/2025 11:33
EI MiCODUS 2G Device Firmware Upgrade Steps 25/08/2025 10:49

Note: When extracting the device’s upgrade firmware package, do not close the
upgrade software interface opened in the previous step.
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2. Return to the upgrade software interface, locate the “Image Folder” option,
navigate to the folder containing the firmware package to be upgraded (e.g.,
MV710 MV790 241031A), select the folder, and confirm.

8 Multiple Download Tool - Engineer Mode - X
File Factory Database Options DebugLlogging Identify Help

DA file name  [D:\Upgradation steps Browse for Folder X N00NoutputMTK_AllinOne_DA bin
" Authentication file I Select Image Folder:
' RootCert file I
" ’ Firmware for MV710 MV720 MV730 MV740 MV790
| Certificate File I :
QMDownload
Scatter/Config Files Folder Path Upgradation steps =
Image Folder | I Driver for Program Reload
| Firmware for MV710 MV720 MV730 MV740 MV790 COM Port
[~ selal [~ Selal Firmware Upgrading Program & UART
[ COM3 [ Auto poli V"’;@t‘";’f  use
xwechat_files
i = @
v coma [ utopollfng4 . I\ MeTEH UART + USB
v COM5 [ Autopoling5 @ Bl Desktop I—_!
W COMB [~ Autopoling& (@ Baudrate |921600 v
¥ COM7 [ Autopoling 7 . Download/Format |
v COM8 [ Autopoling8 @ Cancel Operation

¥ COM3 [~ Autopolingd @ [ ot
¥ COM10™ Auto poling 10 Osec  Start | Stop |
[V COM11[™ Auto palling 11. Osec  Statt | Stop |
¥ COM121~ Auto poling 124 Dsec  Start | Stop |
¥ COM13™ Auto poling 13@ Osec  Start | Stop |
v COM14T™ Auto poling 14 @@
¥ COM15[ Auto poling 15
[V COM16[™ Auto poling 18.
¥ COM17[ Auto poling 17 @@
¥ COMI8[™ Auto poling 18

Download ROM v

Osec  Statt | Stop |
Osec  Start | Stop |
Osec  Start | Stop |
Osec  Stat | Stop |
Osec  Start | Stop |

RIS IR =

Start All | Stop all

(VIl) Confirm Firmware Upgrade Settings

In the upgrade software interface, verify that the upgrade settings are as shown in the
figure below.

o] Multiple Download Tool - Engineer Mode - X
File Factory Database Options DebugLlogging |dentify Help
|D:\Upgtadaﬁan steps\Firmware Upgrading Program\Multiport_download_exe_v5.1624.00.00%output\h TK_aAllnOne_DA. bin

DA file name:

| Authentication file |

' RootCert file |

| Ceificate File |

Scatter/Config Files Folder Path
|D:\Upgradation stepsFirmware for My710 My720 M730 My 740 My790 Reload

COM Port

« UART

" Use

" UART + USB

[~ Selal [~ Selal

[v COM3 [ Auto poling 3 .
Vv COM4 [ Auto poliing 4 .
v COM5 [~ Autopoling5 @

Osec Start | Stop

0sec

Osec  Start | Stop

v COME [ Auto poling 6 . Dsec  Stat | Stop Baud rate | 921600 v!
BPitong L Asspeto . Osec _Start | Stop | ownload/Format |

[v COM8 [~ Autopoling8 @)
[v COM3 [ Auto poling 9 .

Osec  Start | Stop Operation
Osec  Start | Stop Dowrload ROM v

¥ COM10[™ Auto poling 10@)
v COM11[™ Auto poling 11.
[¥ COM12[~ Auto poling 12
[¥ COM13[™ Auto poling 13@)
[V COM14[~ Auto poling 14 @)
¥ COM15[™ Auto poling 15@)
v COM16]™ Auto poling 15.
¥ COM17[~ Auto poling 17 @)
¥ COM18[~ Auto poling 18@)

Osec  Start | Stop
Osec  Start | Stop
Osec  Stat | Stop
Osec  Start | Stop
Osec  Start | Stop
Osec  Start | Stop
Osec  Start | Stop
Osec  Start | Stop
Osec  Start | Stop

I EIEIEIEIEI EIE I EIEEE

Start All Stop All
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VIIl) Select Download Items

In the upgrade software interface, click the “File” menu and select “Scatter and
Load”.

L] Multiple Download Tool - Engineer Mode - X

(

File Factory Database Options DebugLlogging Identify Help

Open Download Agent File are Upgrading Program‘\Multiport_download_exe_v5.1624.00.00\output\MTK_AllnOne_DA bin
Open Authentication File

Scatter and Load hﬁ 2

Open Root Cert File
Open Certificate File

PLOUGI LU Y T HSS 1 LIUGE 1 g

|D:\Upgradation steps\Firmware for My710 MV720 M¥730 My740 MY790 Reload |
COM Port
[].5elal [ Selal + UART
WtUM3 [ Auto poling 3 . ( 0% ] 0Osec Stat | Stop |  Use
v COM4 [ Auto poling 4 . [ 0% | Osec Stat | Stop | " UART +USB
[V COMS [~ Autopoling5 @ [ 0% | 0Osec Stat | Stop |
[ COME [ Autopoling& @) [ 0% | Osec Stat | Stop | Baudrate |321600 -
v COM7 [ Autopoling 7 . | 0% | Osec Start | Stop | CErlean/E ot |
[V COMS8 [ Autopoling& @@ [ 0% | Osec Start | Stop | Dperation
v COM3 [ Autopoling3 @ | 0% | Osec Stat| Stop | Dowrload AOM ]
[V COM10I™ Auto poling 104 [ 0% | Osec Start | Stop |
[V COM11T™ Auto poling 11 [ 0% | Osec Stat | Stop |
[V COM12[ Auto poling 124 [ 0% | Osec Stat | Stop |
[V COM13/ Auto poling 13@ [ 0% | Osec Stat | Stop |
[V COM14] Auto poling 14¢) [ 0% | Osec Start | Stop |
v COM15[ Auto poling TS. | 0% | Osec Stat | Stop |
¥ COMI6[™ Auto poling 164 [ 0% | Osec Stat | Stop |
¥ COMI7[" Auto poling 17 [ 0% | 0Osec Start | Stop |
[V COM18]™ Auto poling 154 [ 0% | Osec Stat | Stop | Start Al Stop Al |

IX) Select the GPS Download Option

1. In the new pop-up window, locate the relevant options and check only the “GPS”
download item. Ensure that all unrelated download items remain unchecked.
B4 Please select enable auto loaded images = [} X

|D‘.\Upgradation steps\Firmware for MV710 MV720 MV730 MV740 MV790\Firmware for MV710 MY720 MV730 M‘j

ARM_BL D:\Upgradation steps\Firmware for MY710 MY720 MY730 MY740 MY790\Firmware for MV710 Mv720 Bd‘OtROM
ARM_EXT_BL D:\Upgradation steps\Firmware for MV710 Mv720 MV730 MV740 MV730\Firmware for MV710 M uss
PRIMARY_MAUI DA\Upgradation stepsiFirmware for MY710 MY720 My730 My740 MY 7904Firmware for MY71C Download
VYA DiUpgradation steps\Firmware for MY710 MY720 MY730 MY740 MY 7904Firmware for MV710 MV720 My
MIGPS D\Upgradation stepshFirmware for MY710 MV720 My730 My740 MYV790%Firmware for MY710 MY720 MY
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2. After selecting, close the pop-up window.

B0 Please select enable auto loaded images — O

|D:\,Upgradation steps\Firmware for MY710 My720 MY730 MY740 MV790\Firmware for My710 MY720 MV730 M‘j

ARM_BL D:iUpgradation stepshFirmware for My710 MY720 Mv730 MY740 MV 7904Firmware for MV710 MY720
ARM_EXT_BL D:\Upgradation stepshFirmware for MY710 MV720 MY730 MV740 MY 7904Firmware for MY710 M U
PRIMARY_MAUI D:\Upgradation steps\Firmware for Mv710 MY720 MV730 MY740 MY 790\Firmware far My71L0 Download
YWIVA  DAUpgradation steps\Firmware for MY710 My720 MY730 My740 MY790\Firmware for MV710 MYW720 MV
L4 GPS D:A\Upgradation stepsiFirmware for My710 MY720 MV730 MV740 My 790\Firmware for MV710 MY720 My

(X) Connect the Device and Start the Upgrade

1. Connect the other end of the configuration cable to the corresponding port on the
2G device to be upgraded, usually located next to the SIM card slot.(Device must
be connected to external power)

Loty 'i I—).WJ.

Note: The device must be connected to external power and the SIM card must not be
inserted.
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2. In the upgrade software interface, locate the previously noted COM port (e.g.,
COM3) and click the “Start” button corresponding to that COM port to begin the
upgrade.

L] Multiple Download Tool - Engineer Mode - X
File Factory Database Options DebugLlogging Identify Help

DA file name |D:\Upgtadation steps\Firmware Upgrading Program‘Multiport_download_exe_v5.1624.00.00%utput\M TK_AllnOne_DA.bin

Authentication file I

|
| RootCertfle |

Certificate File |

| [ Scatter/Config Files Folder Path
e F ID:\Uwadaﬁon steps\Firmware for MY710 MV720 MY730 My740 My730

COM Port
[~ SelAll [~ SelAll & UAR
|5 covs T sutopolings @ DLGPS 32sec  Start | Stop | | | ouss
[~ COM4 [ Autopoling 4 . Osec  Start ] Stop ] € UART +U

[~ COMS [~ Autopaling5 @
[~ CcOMB [ Autopoling 6 .
[~ coM7 [~ Autopoling 7 @
[~ COM8 [~ Autopoling8 @@
[~ COM3 [ Autopoling9 .
[~ COM10[™ Auto poling 104
[~ COM11]™ Auto polling 11 .
[~ COM12[~ Auto polling 124
[~ COM13[™ Auto polling13.
[~ COM141~ Auto poling 14 @)
[~ COMI5[™ Auto pouing15.
[~ COMIBI™ Auto poling 154
[~ COM17]" Auto poling 17 @)
[~ COM18[™ Auto poling 184

Osec  Stat | Stop | —]—_I
Osec  Stat | Stop | Baudrate [321600 )
Osec  Start | Stop | Download/Format |

Osec  Start | Stop | Operation
Osec  Stat | Stop |
Osec  Start | Stop |
Osec  Stat | Stop |
Osec  Stat | Stop |
Osec  Start | Stop |
Osec  Stat | Stop |
Osec  Start | Stop |
Osec  Start | Stop |
Osec  Start | Stop |
Osec Start | Stop |

Download ROM v

DDDDDDGDDDDDDD:I!‘
SOl (ool ool | aelfae| foe]fae][oe]| a2 [ 2| o2 [ 2| e[| 2| FE[NFe

Stop All

Note: Ensure the device port is firmly connected to avoid poor contact. During the
upgrade, do not disconnect the device from the computer or close the upgrade
software.

(XI) Complete the Upgrade

When the upgrade progress for the COM port reaches 100% and the progress bar
turns green in the upgrade software interface, click the “Stop All” button to complete
the upgrade.

L] Multiple Download Tool - Engineer Mode = X
File FactoryDatabase Options DebugLlogging Identify Help
DA file name |D:\Upgadaﬁun steps\Firmware Upgrading Program'\Multiport_download_exe_v5.1624.00.00%utput\M TK_AllnOne_DA.bin
Authentication file I
| RootCert file I
Certificate File I

| [ Scatter/Config Files Folder Path

[D:\Upgradation steps\Firmware for MY710 Mv720 My730 MV740 MV730 ;
COM Port
I~ SelAll [~ Selal & UAF
[v COM3 [ Autopoling3 @ IDLGPS ok I I4z sec _Stat | Stop € use
[~ COM4 [ Autopoling 4 @) T 7 " Osec Stat | Stop | C UAF
[~ COMS [ Autopoling5 @) Osec Stat | Stop |
[~ coMs [~ Autopoling6 @ Osec _Start | Stop | Baudrate [320600 <]

[~ COM7 [ Autopoling7 @
[~ COM8 [~ Auto poling 8 .
[~ cOM3 [ Autopolingd @
[~ COM10™ Auto poling 10
[~ COM117™ Auto poling 11 @)
[~ COM12I~ Auto poling 12
[~ COM137™ Auto poling 13@)
[~ COM14T~ Auto poling 14@)
[~ COM15T™ Auto poling 15@@)
I~ COM16I™ Auto poling 16¢)
[~ COM17™ Auto poling 17@@)
[~ COM18I™ Auto poling 18€)

Osec Stat | Stop | Download/Format I

Osec Start | Stop | Operation
Osec Stat | Stop |

load ROM

Osec Stat | Stop |
Osec Stat | Stop |

Osec  Start | Stop |
Osec Stat | Stop |
Osec Start | Stop |
Osec Stat | Stop |

Osec Stat | Stop |
Osec Start | Stop |

Dsec  Start | Stop | Start All Stop All
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IV. Notes and Precautions

(I) Risk Warnings During the Upgrade

1. Forcibly disconnecting the device from the computer during the upgrade may
damage the device firmware, preventing the device from starting properly. Ensure
the connection remains stable throughout the process.

2. Using an upgrade firmware package that does not match the device model may
result in upgrade failure or even damage device functionality. Always select the
software package according to the device model.

(I1) Upgrade Environment Requirements

1. During the upgrade, the computer must remain stable. Avoid crashes or restarts.
It is recommended to close unrelated programs on the computer.

2. The upgrade environment should be dry and dust-free to prevent dust from
affecting the connection between the device and the configuration cable.

(Ill) Handling Special Situations

1. Ifan “ERROR” message appears during the upgrade, click the “Stop” button to
halt the process. Check that the configuration cable is firmly connected, the
correct firmware package is selected, and the COM port is correct. Resolve any
issues before attempting the upgrade again.

2. If the upgrade fails and the device cannot start normally, do not attempt to
disassemble the device yourself. Contact professional technical personnel for
assistance.

(IV) Other Notes

1. After the upgrade, verify that the device time matches the actual time to confirm
the upgrade was successful.

2. It is recommended to record the upgrade process to provide a reference for
technical personnel in case of issues.

3. This upgrade addresses only the GPS time synchronization issue. Other device
functions and usage methods remain unchanged after the upgrade.

Shenzhen MiCODUS Electronic Technology Co., Ltd.
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